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1 General 
1.1 Installation 
Installation Guide 

The Bartels AutoEngineer Installation Guide (file inste.htm from the baedoc directory of the BAE-CD-ROM) provides 
detailed Bartels AutoEngineer installation instructions for all supported hardware and software platforms. 

Automatic Parameter Configuration Update 

Previously, new configuration parameters in the bae.ini configuration file had to be added manually after every BAE 
update installation. This is now done automatically when first starting BAE after installing a software update by appending 
a version-specific difference file to the existing bae.ini file. 

1.2 User Interface and General Functions 
Module-specific Color Table Configurations 

Module-specific color table configurations are supported through bae<moduleid>.col color table names. The RGB 
values for the BAE color palette are loaded from bae.col if no module-specific color table file is available. This allows for 
the definition of a white background color table configuration in baescm.col for the Schematic Editor whilst still using 
black background color table configurations in the layout modules. The Schematic Editor has been optimized for white 
background display configurations. Predefined BAE system color files for white background configurations, 
bae256_i.col for Windows and baeunix_i.col for Linux/Unix are provided with the software. Simply copy the file for 
your operating system to baescm.col in the BAE programs directory to configure a white display background for the 
Schematic Editor. 

Command History and Command Repetition 

The last 50 menu selections are now available for re-selection with the right mouse button pressed. Cursor keys can be 
used to scroll through the menu selection list. Releasing the mouse button activates the currently selected/highlighted 
menu selection. Scrolling back automatically activates a command loop to the last menu item. The right mouse button 
repeats the command sequence until a different menu item is selected. The s key can be used to save the command 
sequence whilst the right mouse button is pressed, and the l button canbe used to re-activate the save command 
sequence. 

Key Programming 

The key programming functions available through key 5 have been extended to allow for the programming of special keys 
such as Strg key combinations, and Tab, Esc, Enter and Del keys. The menus include indicators for shortcut keys 
assigned to menu functions. 

Horizontal Scroll with Mouse Wheel 

The mouse wheel is used to scroll the graphic display vertically. Turning the mouse wheel with the Shift key pressed 
causes the graphic screen to scroll horizontally. 

Windows and Motif Menu Shortcut Key Display 

Shortcut key indicators have been added to the key-programmed menu entries of the Windows and Motif menus. 

Favourites Menu 

The F button for activating a user-defined menu has been added to the toolbar. This menu provides the Edit Favourites 
function for configuring the favourites menu. BAE module-specific favourites menu configurations are stored to the 
baeparam.dat file in the BAE programs directory. 

Macro Command Definitions 

The M button for activating a function for storing and activating command sequences has been added to the toolbar. 
Macro command sequences can be created by selecting functions from the menu and/or the command history (up to 50 
previously called menu functions). Both the key programming facilities and the favourites menu support macro command 
calls. Module-specific macro command sequences are stored to the baemacro.dat in the BAE programs directory. 
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Element History 

The H button for quickly accessing the recently stored elements has been added to the toolbar. Special entries in the 
bae.ini file can be set to restrict the history to recently loaded elements and/or SCM sheets and/or layouts. The 
element history is stored to the baehist.dat file in the BAE programs directory. 

Mathematical Expressions in Numeric Input Dialog Elements 

The Windows and Motif dialog elements for numerical value input have been changed to support mathematical 
expressions. Any mathematical expression in the input field is evaluated upon = input, when leaving the input field or 
when exiting (not aborting) the dialog box. The + (add), - (subtract), * (multiply), / (divide) and ^ (power) operators, the 
constant pi and the abs (absolute value), cos (cosine), exp (exponent), log (natural logarithm), sin (sine), sqrt 
(square root) and tan (tangent) functions are supported. Parentheses can be used to redefine the evaluation sequence. 

Windows File Associations 

The DDB file selection dialog of the BAE Windows version has been changed to support associations. Adding 
associations for, e.g., library files in project directories simplifies file selections significantly. 

Arc/Circle Processing 

Full circle definitions with redundant end points close to the circle start point caused sporadic problems. Arcs which 
obviously span a full circle are now automatically splitted into two arcs to avoid these problems. This transformation is 
also applied when loading older DDB files. 

1.3 Symbol and Part Libraries 
The Bartels AutoEngineer layout library has been updated and supplemented by new definitions. 
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2 Schematic Editor 
2.1 General 
File Element Selection 

The Newest Project Sheet, Newest Sheet, Newest Symbol, Newest Label und Newest Marker options for loading the DDB 
file element with the latest modified date have been added to the File / Load menu and the corresponding toolbar button.  

According to this function, the last saved project SCM sheet is automatically loaded when switching to the Schematic 
Editor module without preset SCM sheet name. bae.ini entries can be used to set a fixed SCM sheet name for 
automatic load. 

Display Parameter Dialog 

The Settings dialog from the View menu has been added to the middle mouse button display menu. 

Grid Selection 

The 2.5 mm and 0.25 mm grid options have been added to the menus for setting the input and display grid. 

The 0.25 * Display Grid, 0.5 * Display Grid, Display Grid and 2.0 * Display Grid options for automatically adjusting the input 
grid to display grid settings have been added to the Input Grid menu of the display settings dialog. The 0.25 * Input Grid, 
0.5 * Input Grid, Input Grid and 2.0 * Input Grid options for automatically adjusting the display grid to input grid settings 
have been added to the Display Grid menu of the display settings dialog. 

Zoom Window Selection through Toolbar 

Left mouse button interactions in the toolbar's element overview window have been changed to cause a Center/Pan 
Window to the selected position instead of activating the Zoom Last function. 

Project Net Highlight 

The Highlight Net has been changed to keep highlights for named nets when loading different schematic sheets from the 
same project file. BAE HighEnd supports this feature when selecting nets on the project layout. 

Project net highlight is now also supported for nets connected to bustaps if the corresponding bus and bustap names 
provide unique net identification. 

The Reset Highlights function can be used to clear all net highlights. 

Highlight Focus 

The Highlight Focus On/Off for activating and/or deactivating the exclusive display of highlighted elements has been added 
to the Ansicht menu. This simplifies the localisation of errors and/or highlighted nets, especially when using white display 
backgrounds. The Reset Highlights function automatically resets the highlight focus. 
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2.2 Symbols, Labels 
Repeated Symbol/Label Placement 

Features for label placement support and the preservation of non-default name and attribute text positioning have been 
added to the toolbar windows for placing symbols with pre-defined attribute values. 

The Copy Symbol function for copying selectable symbols and/or labels has been added to the Other Functions submenu 
of the Symbols menu. 

Label Macro Selection 

The Change Macro function has been added to the context menu of the Add Label function to allow for non-default label 
macro selections when placing labels for nets without corresponding label macro. 

Label Check 

Label and bustap coordinates have been added to the single label and bustap reference output listing of the Check Labels 
function from the Other Functions submenu of the Symbols menu. Any selection of a label and/or bustap name 
automatically loads the refering SCM sheet and zooms to the selected label and/or bustap. 

Next Pin Placement 

The Next Symbol/Label function has been extended to allow for placing pins on symbol level. The new pin name is derived 
from the name of the last placed pin by incrementing the last number from the previous pin name; alternatively, the last 
letter is replaced by the next letter if the pin name doesn't contain a number. The rotation angle and mirror mode of the 
previously placed pin are used as defaults for placing the new pin. Any Jump relative placement operation is carried out 
relative to the position of the previously placed pin. 

Placement Status Display (BAE HighEnd) 

In BAE HighEnd, the frames of SCM symbols/parts are displayed according to the placement status of the corresponding 
layout part if both the project's schematic sheet/plan and the project's layout are open. A dashed (-----) symbol frame is 
displayed for unplaced layout parts, and a dashed/dotted (-.-.-) symbol frame is displayed for placed layout parts. 

2.3 Connections 
Moving Connection Corners 

The new Move Corner can be used to move connection corner points. This is useful for correcting bus segment lengths. 
The function performs a Move Segment operation on the connection segment closest to the pick point if more than one 
connection segment ends at the selected corner point. 

Bus Tap Signal Rerouting 

Bus tap connections are now automatically re-routed when using the Move Bus Tap, Move Segment and Move Group 
functiona. 

Bus Tap Function with Name List Display 

The List button for displaying a list of existing bus tap names has been added to the bus tap name dialog of the Tap Bus 
function. Connected symbol bus pins are displayed at the beginning of this list, and the pin name is used as bus tap name 
when connecting a symbol bus pin. This simplifies the connection of symbol bus pins significantly if symbol bus pin names 
are defined according to valid bus tap range names such as d(0-7). 

Bus Tap Cross Reference 

A section for listing bus taps with bus names and bus tap counts for each SCM sheet has been added to the output of the 
SCM Cross Reference function from the Other Functions submenu of the Symbols menu. 

Automated Connection Pattern Generation 

The Draw Pattern function for automated connection pattern (e.g., connection combs, multiple parallel connections) 
generation has been added to the Other Functions submenu of the Connections menu. 
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2.4 Graphics 
Graphic Line Widths 

The Set Polygon Line Width submenu with the Change, Set and Set Group functions for changing and/or setting graphic 
line widths has been added to the Other Functions submenu of the Graphic menu. 

Graphic Line Dash Modes 

The Dash Mode submenu with the Change, Set and Set Group functions for activating dash mode and line width dialogs 
has been added to the Other Functions submenu of the Grafik menu. 

2.5 Text, Attributes 
Text Settings 

The functions for adding and/or editing texts have been changed to memorize not only the text size but also text rotation, 
text mirror mode and text string for subsequent Add Text calls. 

Symbol Reference Display during Move Name and Move Attribute Operations 

The Move Name and Move Attribute functions are displaying a line to the placement point of the corresponding symbol 
whilst selecting the new name and/or attribute text position. This helps to the identify the currently processed symbol if 
other symbols are placed closely. 

Text Line Widths 

The Set Text Plot Width submenu with the Change, Set and Set Group functions for changing and/or setting text line 
widths has been added to the Other Functions submenu of the Text menu. 

Text Class Assignments to group-selected Texts 

The Group Assignment option for assigning text classes to all group-selected texts has been added to the Text Class 
function of the Other Functions submenu of the Text menu. 

2.6 Group Functions 
Group Matrix Copy 

The Copy Matrix function for creating matrix copies of the currently selected group has been added to the Other Functions 
submenu of the Edit menu. 

2.7 Plot Output 
Standard Pen Width for Lines and Texts 

The HP Laser Output and Generic Output functions of the BAE Windows versions have been changed to use the Plotter 
Pen Width setting for plotting lines and texts instead of drawing pixel lines depending on the output device raster 
resolution. 

EPS/PDF Output 

The EPS/PDF Output dialog has been extended to allow for the selection of the output character font (either the BAE 
vector font or a PostScript font). 

A button for deactivating comment text output has also been added to the dialog. 
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3 Packager 
3.1 Log File Update 
The update of the Packager log file (bae.log) was completed only after exiting the Packager module. This behaviour 
has been changed, the log file contents is now updated immedialtely after finishing the packaging process. 

3.2 Controlling Logical Part Definition Assignments 
The $rlext (Requested Logical Library Name Extension) attribute is provided in addition to the $rlname (Requested 
Logical Library Name) attribute for logical part definition assignments. $rlname allows for direct logical part definition 
specifications, whereas $rlext assigns a logical definition with a name consisting of the predefined logical library 
definition identifier, an underscore (_) and an extension as specified with the $rlext value. $rlext assignments can be 
used to, e.g., include footprint names with part/symbol names. $rlext also causes the Browse function of the SCM 
attribute assignment dialog to restrict the logical definitions listing to valid selections, wheras $rlname lists all logical 
definitions. 

3.3 Swap Restrictions 
Logical library swap definitions for parts with fixed layout part name assignments through $rpname (Requested Part 
Name) and $vgrp (Variant Group) attributes are now automatically set to internal to prevent the Layout Editor from 
swapping affected gates. Previously, such swaps were possible but would have been reset by the Packager. 
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4 Layout Editor 
4.1 General 
File Element Selection 

The Newest Project Layout, Newest Layout, Newest Part, Newest Padstack and Newest Pad options for loading the DDB 
file element with the latest modified date have been added to the File / Load menu and the corresponding toolbar button. 

Loading the Default Layout at Module Startup 

The project layout with the default layout element name defined in the setup is automatically loaded when switching to the 
Layout Editor module without preset layout name. bae.ini entries can be used to set a fixed layout name and/or select 
the last saved project layout for automatic load. 

Cross and Center Point Snap Functions 

During part placement and trace and/or polygon editing, the Cross Point and Interpolated Center functions for selecting 
polygon crossing point or interpolated arc center point coordinates are now available through the x key. The arc center 
point snap routines are tolerant enough to allow even for rectangle center point calculations. 

4.2 Display, Design Rule Check 
Grid Selection 

The 2.5 mm and 0.25 mm grid options have been added to the menus for setting the input and display grid. 

The 0.25 * Display Grid, 0.5 * Display Grid, Display Grid and 2.0 * Display Grid options for automatically adjusting the input 
grid to display grid settings have been added to the Input Grid menu of the display settings dialog. The 0.25 * Input Grid, 
0.5 * Input Grid, Input Grid and 2.0 * Input Grid options for automatically adjusting the display grid to input grid settings 
have been added to the Display Grid menu of the display settings dialog. 

The Octagon mode can now be applied specifically to Traces, Areas or Traces+Areas. The Traces octagon mode is 
selected when loading layout elements with octagon mode settings from previous BAE versions. 

Zoom Window Selection through Toolbar 

Left mouse button interactions in the toolbar's element overview window have been changed to cause a Center/Pan 
Window to the selected position instead of activating the Zoom Last function. 

Signal Layer Settings through Toolbar 

Buttons for quick color selection for the first 8 signal layers have been added to the toolbar of the layout system. Left 
mouse button clicks on the color button allow for color selections according to the Change Colors, while right mouse 
button clicks toggle the visibility of the signal layer. Left mouse button clicks on the signal layer name/label set the default 
input layer. The layer label/name display of the currently selected default input layer is inverted. Subsequent left mouse 
button clicks on the signal layer name of the currently selected preference layer toggle the screen visibility of all other 
layers. 

Layer Selection 

The < and > buttons for scrolling layer selection lists have been added to the Change Colors function from the View menu 
and to the documentary layer selection menus. 

Distance Query 

The Distance Query function has been changed to display not only the current X and Y coordinates but also the current 
distance to the selected start point whilst selecting the distance query end point. 

Design Rule Check Error Listing 

Part type errors and short-circuit net names have been added to the design rule check error listing displayed with the 
DRC Error List function from the Utilities menu. A mouse click on any of these error list entries triggers a Zoom Window 
operation to the erroneous part and/or the rectangle surrounding the pins of the short-circuit net. 
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Airline Display Net Selection 

The Part Nets Visible, Part Nets Invisible, Pin Net Visible and Pin Net Invisible net airline display options for selecting part or 
pin specific nets have been added to the Settings dialog from the Settings menu. 

Airline Density Display Dialog 

The Airlines Density function from the Utilities menu has been changed to use a dialog box for displaying the airline 
density diagram. 

4.3 Parts, Placement 
Part Swap with Name and Attribute Text Position Memory 

The Swap Parts function from the Other Functions submenu of the Parts menu has been changed to preserve the name 
and attribute text positions of the swapped parts as defined with Move Name and Move Attribute. 

Next Pin Placement 

The Place Next Part function has been extended to allow for placing pins on part level. The new pin name is derived from 
the name of the last placed pin by incrementing the last number from the previous pin name; alternatively, the last letter is 
replaced by the next letter if the pin name doesn't contain a number. The rotation angle and mirror mode of the previously 
placed pin are used as defaults for placing the new pin. Any Jump relative placement operation is carried out relative to 
the position of the previously placed pin. 

Part Placement with Dynamic Distance and Airline Length Display 

The current distance to the previous part placement position has been added to the X/Y position placement status display 
of the Move Part function. 

The current H+V airline length of the currently placed part is now displayed in the status field when placing parts with Add 
Part and/or Place Next Part and dynamic airline display activated. 

Logical Pin Name Query 

A column named LOGICAL NAME for displaying logical/SCM pin names has been added part pin data table to the output 
of the Place Data Query function. 

Find SCM Symbol (BAE HighEnd) 

The Find SCM Symbol function in BAE HighEnd has been changed to display the SCM symbol list when applied on 
layout parts consisting of different SCM symbols. After selecting a certain symbol position, the + and - keys can be used 
to switch to the next and/or previous symbol position. 
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4.4 Traces, Routing 
Trace Length Display 

During interactive routing, the length of the currently processed trace is now displayed in the status field together with the 
current X and Y coordinates. 

Highlight Focus 

The Highlight Focus On/Off for activating and/or deactivating the exclusive display of highlighted and/or net-colored 
elements has been added to the Highlight Net submenu. This feature works on net highlights, short-circuit highlights and 
group highlights. I.e., highlight focus can be used to emphasize net highlights, check group selections and localise short-
circuits. The Reset All function automatically resets the highlight focus. 

Via Optimization 

The Vias: optimize and Vias: preserve options have been added to the Settings dialog of the Settings menu. Vias: optimize 
(default setting) causes the system to replace and/or optimize vias during manual routing. Vias: preserve forces the 
system to keep vias and padstack macro types even if these vias are not in the currently configured via list or if these 
(blind and buried) vias are occupying more than the least required and/or possible set of layers. 

Teardrop Generation 

The submenus of the Create Teardrops function have been replaced by a teardrop parameter dialog with a new with Drill  
button for quickly selecting all padstack macros with drill holes. 

Trace Impedance and Layer Stackup (BAE HighEnd) 

The Impedance submenu with the Impedance Query and Set Impedance functions for querying and/or setting trace 
impedance characteristics has been added to the Other Functions submenu of the BAE HighEnd Traces menu. 

The Layer Stackup function from the Rule Attachment submenu of the Settings menu can be used to enter the necessary 
layer stackup information for trace impedance calculations. 
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4.5 Graphic, Copper Areas 
Drawing Utilities 

The Drawing Utilities function from the Other Functions submenu of the Areas menu have been changed to support the 
creation of keepout areas when generating rectangular and/or circular polygons. An Undo function and options for 
selecting the layer and polygon type have been added to the context menu to be activated with the right mouse button 
when placing the first polygon point. This allows for the generation of rectangular and/or circular polgygons with different 
types on different layers through a single menu function call with the option to correct erroneous inputs. 

Polygon Line Widths 

The Set Polygon Line Width submenu with the Change, Set and Set Group functions for changing and/or setting 
documentary line widths and power layer isolation widths has been added to the Other Functions submenu of the Areas 
menu. 

Polygon Line Dash Modes 

The Dash Mode submenu options from the Other Functions submenu of the Areas menu have been replaced by the 
Change, Set and Set Group functions for activating dash mode and line width dialogs. 

Split Polygons 

The Doc.lines Split from the Other Functions submenu of the Areas menu has been renamed to Split Polygons and 
supports now also the splitting of areas along the line between two selectable polygon corner points. 

Polygon Outline Keepout Area Processing 

The Create and Delete options have been implemented for the Border Keep Outs function from the Other Functions 
submenu of the Areas menu. Create is used to create polygon outline keepout areas for selectable documentary lines 
and/or the board outline. Delete can be used to delete outline keepout areas of selectable polygons previously created 
with the Create option. 

Warning 

Polygon outline keepout areas created with previous BAE versions cannot be deleted automatically. 

4.6 Text, Drill 
Text Settings 

The functions for adding and/or editing texts have been changed to memorize not only the text size but also text rotation, 
text mirror mode and text string for subsequent Add Text calls. 

Centered Text 

The Centered option for centering texts on LOGICAL documentary layers has been added to the context menu available 
through the right mouse button during text placement. The text placement reference point for centered text is the text 
base line. The Align Left context menu option is provided for restoring text left-alignment. 

Part Reference Display during Move Name and Move Attribute Operations 

The Move Name and Move Attribute functions are displaying a line to the placement point of the corresponding parts whilst 
selecting the new name and/or attribute text position. This helps to the identify the currently processed part if other parts 
are placed closely. 

Text Line Widths 

The Set Text Plot Width submenu with the Change, Set and Set Group functions for changing and/or setting text line 
widths has been added to the Other Functions submenu of the Text, Drill  menu. 
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4.7 Group Functions 
Part Area Selection 

The Part Area function has been added to the group placement reference point selection context menu of the Move Group 
function. Part Area restricts group movements to the element boundaries of the selected part. This feature can be used 
together with Other Functions / Select / All  to move a part with all connected trace end points. 

Group Polygon 

The Select Polygon function for selecting and/or deselecting elements within an already placed polygon has been added 
to the context menus of the Group Polygon functions. This allows for the quick selection and/or deselection of elements 
inside the board outline or a fill area or any other area and/or polygon outline. 

4.8 Automatic Copper Fill 
Automatic Cutout Area Polygon Correction 

The copper fill functions have been changed to create rectangular cutout areas in place of problematic cutout polygons to 
safely avoid the generation of short-circuits. Such problems are usually caused by concave cutout polygon segments with 
a size smaller than the sum of the minimum distance and the minimum structure size. The copper fill functions issue 
warning messages about any cutout polygon area fixes and group-select the polygons and/or parts which caused these 
problems. 
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5 Autorouter 
5.1 General 
Default Autorouter Control and Strategy Parameter Settings 

New entries for automatically setting default Autorouter control and strategy parameters have been added to the 
bae.ini file. 

Airline Display Net Selection 

The Part Nets Visible, Part Nets Invisible, Pin Net Visible and Pin Net Invisible net airline display options for selecting part or 
pin specific nets have been added to the Settings dialog from the Settings menu. 

5.2 Autorouter Algorithms 
Task Priority 

An entry for setting the Autorouter task priority has been added to the bae.ini configuration file. 
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6 CAM Processor 
6.1 General 
CAM Batch Configuration Database 

The CAM Batch Output function for managing a CAM batch configuration database has been added to the Import/Export 
submenu of BAE Windows and Motif File menus. 

The CAM batch configurations are stored to the cambatdb.dat file in the BAE programs directory. The cambatdb.dat 
file installed with the BAE software contains a few predefined CAM batch configurations such as Sieb & Meyer, Gerber 2.4 
(batch output with standard Gerber parameter settings according to the CAMBATCH User Language program) and Sieb 
& Meyer, Ext. Gerber 2.4 (batch output with Gerber parameter settings for minimized output data file size). Please note 
that the Sieb & Meyer, Ext. Gerber 2.4 batch configuration might not be supported by older Gerber plotter models. 

CAM Batch Output provides a series of features such as programmable multilayer plot configurations, HPGL outputs and 
EPS/PDF batch outputs which are not available through the CAMBATCH User Language program. 

Gencad 1.4 Export 

The Gencad 1.4 Output function for exporting the currently loaded layout data to GENCAD 1.4 format has been added to 
the Import/Export submenu of the File menu. 

HyperLynx Output 

The HyperLynx Output function for exporting the currently loaded layout data to HyperLynx format has been added to the 
Import/Export submenu of the File menu. 

6.2 Control Plot 
Standard Pen Width for Lines and Texts 

The HP Laser Output and Generic Output functions of the BAE Windows versions have been changed to use the Plotter 
Pen Width setting for plotting lines and texts without line width assignment instead of drawing pixel lines depending on the 
output device raster resolution. 

EPS/PDF Output 

The EPS/PDF Output dialog has been extended to allow for the selection of the output character font (either the BAE 
vector font or a PostScript font). 

The Visible B/W option for monochrome (black on white)output of the the currently visible layers has been added to the 
output layer selection menu. 

A button for activating EPS/PDF batch output database management functions has been added. The EPS/PDF batch 
parameter are stored to the epsbatdb.dat file in the BAE programs directory. Any EPS/PDF batch output can consist of 
different EPS/PDF output files with different combinations of output pages and/or BAE output layer sets. 

6.3 Drilling Data Output 
Drill Class Selection 

A drill class selection dialog listing all layout drill classes with drill counts has been added to the Drill Output and Excellon 
Drill Out functions. 
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7 Neural Rule System 
Rule Definitions 

The brules.vdb file installed to the BAE programs directory contains precompiled rule definitions. The source files for 
these rule definitions are also provided (User Language directory; file extension .rul), i.e., the rule definitions can be 
modified and recompiled with the RULECOMP Rule System Compiler. 

8 Utilities 
8.1 LOGLIB 
The LOGLIB utility program has been changed to support net attribute definitions through netattr commmands for 
symbols which are not declared virtual. 
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9 Bartels User Language 
9.1 General 
This section describes general changes to the User Language specification. See the Bartels User Language 
Programmer's Guide for a detailed description of the User Language specification. 

Internal User Language Version 

The internal version of BAE Version 6.2 User Language has been changed. User Language programs compiled under 
earlier BAE versions won't execute in the BAE Version 6.2 User Language Interpreter environment (error message 
User Language program version incompatible!). This means that each User Language program compiled 
under earlier BAE Versions must be recompiled under BAE Version 6.2 to regain compatibility. 

9.2 Index Variable Types 
This section lists the new and changed User Language index variable type. See the Bartels User Language 
Programmer's Guide for a detailed description of all index variable types. 

Changed Index Variable Types 
The int attribute VIS for net visibility queries has been added to the L_CNET index variable type. 
The WIDTH (data type double), DASHLEN (double), DASHSPC (double) and DASH (int) attributes for querying polygon 
line widths and dashed polygon parameters have been added to the C_POLY index variable type. 

The WIDTH (data type double) attribute for querying text line widths has been added to the C_TEXT index variable type. 

The WIDTH (data type double), DASHLEN (double) and DASHSPC (double) attributes for querying polygon line widths 
and dashed polygon parameters have been added to the L_POLY index variable type. 

The WIDTH (data type double) attribute for querying text line widths has been added to the L_TEXT index variable type. 
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9.3 System Functions 
This section lists the new and changed User Language system functions. See the Bartels User Language Programmer's 
Guide for a detailed description of all system functions. 

New System Functions 

The following new User Language system functions have been implemented for BAE Version 6.2: 

IP System Function Short Description 

askcoord Interactive X/Y coordinate value query 

bae_dashpolyline Vectorize dashed BAE polygon 

bae_dialbmpalloc Create BAE dialog bitmap 

bae_dialgettextlen Get BAE dialog text length 

bae_getcmdbuf BAE command history query 

bae_getgridmode Get BAE grid dependency mode 

bae_getinvcolor Get BAE color inversion mode 

bae_inpointmenu Input BAE point/coordinates with mouse and right mouse button callback function 

bae_plansename Get BAE destination element name 

bae_plansfname Get BAE destination element file name 

bae_popmouse Get BAE popup/toolbar mouse position 

bae_setgridmode Set BAE grid dependency mode 

mkdir Create directory 

setprio Set BAE process priority 

STD 

getextprog Get file type specific application 

lay_rulelaysatt Attach rule(s) to layout layer stackup LAY 

lay_rulelaysdet Detach rules from layout layer stackup 

ged_getsegmovmode Get GED trace segment move mode 

ged_getviaoptmode Get GED trace via optimization mode 

ged_setpickelem Set GED default pick element 

ged_setsegmovmode Set GED trace segment move mode 

GED 

ged_setviaoptmode Set GED trace via optimization mode 

Changed System Functions 

The bae_charsize, bae_tbsize and bae_settbsize function parameter data types have been changed from int to 
double. 

The parameter value range of the bae_popsetarea function has been extended to support dialog bitmaps. 

A parameter for controlling the relative dash line distance has been added to the bae_setpopdash function. 

A new class for querying operating system specific directory name delimiters has been added to the bae_swversion 
system function. 

A new layer query type for documentary, signal and power layer selection has been added to the ged_asklayer function. 

The return value and parameter value ranges of the ged_getautocornins and ged_setautocornins functions have been 
extended to support element type specific options. 
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9.4 BAE User Language Programs 
BAE installs some 200 pre-compiled User Language programs to the ulcprog.vdb file of the BAE programs directory. 
Additionally, the User Language source files (more than 4 Mbytes; some 150,000 lines) are installed to a special 
directory (baeulc). See the Bartels User Language Programmer's Guide for a complete listing and short descriptions of 
the BAE User Language programs. 

Include Files 
The User Language include files have been revised and extended by a series of new definitions and 
functions. 

New User Language Programs 

The following new User Language programs are provided with BAE Version 6.2: 

IP Program Name Short Description 

FAVORITE Favorites Menu Management 

HISTORY Element History Call 

STD 

MACRO Macro Command Management 

SYMATTDB Create SQL Attribute Database for SCM Symbol Selection SCM 

SYMSEL SCM Symbol Placement with Attribute Selection 

GENCAD GENCAD 1.4 Layout Data Export LAY 

HYPLYNX HyperLynx Layout Simulation Data Output 

GED GEDPICK Layout Polygon Cross/Center Pick Functions 

CAM CAMBATDB CAM Batch Database 

Changed User Language Programs 

The User Language programs already delivered with the previous BAE Version have been completely revised and 
extended by many new features and functions. A series of significant improvements and enhancements have already 
been mentioned in the previous sections of these Release Notes. 
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